Chapter 10. Mark Up ......................................................... 73
  10.1 Mark up All Trades .................................................. 73
  10.2 Trade Mark up ...................................................... 75
  10.3 Individual Mark up ................................................ 76
  10.4 Trade Totals Display ............................................... 77
  10.5 Report Manager ..................................................... 78

Chapter 11. Pricing Practical ............................................. 79

Chapter 12. Masters .......................................................... 83
  12.1 Master selection .................................................... 83
  12.2 Definitions Menu .................................................. 86
  12.3 Copying bill Items from the Master ............................. 87
  12.4 Pricing Bill Items using the Master ............................... 91

Chapter 13. Post Tender Control ........................................ 95
  13.1 Selling Rate .......................................................... 95

Chapter 14. Value Engineering or Re-modelling ........................ 99
  14.1 Resource List ....................................................... 99
  14.2 Trade Totals Display ............................................... 100
  14.3 Bill of Quantities ................................................... 100

Chapter 15. Summarising Resources into Cost and Group Codes .... 101
  15.1 Resource list ....................................................... 101
  15.2 Defining the Cost and Group codes ............................. 103
  15.3 Allocating the Cost and Group codes to the resources ...... 104
  15.4 Resource Analysis Reports ...................................... 107

Chapter 16. Controlling Labour and Plant using Task Codes .......... 113
  16.1 Defining the Task codes .......................................... 113
  16.2 Task code allocation .............................................. 114
  16.3 Task code analysis ................................................ 117
  16.4 Task code reports ................................................ 120

Chapter 17. Forecasting the BOQ using Candy Planning ............... 125
  17.1 Candy Planning Program Manager ............................. 126
  17.2 Create a new Program ............................................. 127
  17.3 Create program activities using the Bill of Quantities ....... 128
  17.4 Draw your program ................................................ 130
  17.5 B.O.Q with Budget Forecast ..................................... 132
  17.6 Resource usage forecast ......................................... 133
  17.7 Cost code budget .................................................. 134
  17.8 Resource Histogram .............................................. 135

Chapter 18. Valuations ....................................................... 139
  18.1 Valuation Setup .................................................... 139
  18.2 Primary Valuation Quantities .................................... 144
  18.3 Copy the Final quantity from the Bill quantity ............... 144
  18.4 Valuation Report Manager ....................................... 149
  18.5 Valuation Trade Total Display ................................... 155
Chapter 1. Updating from the Internet

1.1 Introduction

The Candy System can be updated from within the system.

Do this:
Open Candy, Click Support &gt; Update Candy

Select Download the latest system, then

Select the closest Server to download from then click

If you are finding that downloading the system is slow, then try a different server.
Click **Start** to initiate download

![Update Candy dialog box](image)

Click **install** to **install version xxxxxxx**.

![Install Candy version 2.00a19](image)
Chapter 2. Starting Up

2.1 Starting Candy

Start the System from the windows desktop by double clicking on the Candy shortcut.

Complete the user Login with your User Name, Initials and Company name.

![Login details](image)

2.2 Company Manager

This is the top-level menu in the system where a maximum of 24 companies can be created.

![Company Manager](image)

For example, if you are tendering in a joint venture with another firm, you can create a brand new company for that bid.

To select a company, position the cursor on the required company and use **Enter** or **Double click**.
2.3 Create a New Company

**Do this**
Click the **Company > New > Company** menu

Edit the company name to read “CCS Training Company”, click **OK**.

**Note:** You may enter a Company Code and a Password for your company.
The company “CCS Training Company” has now been created.

2.4 **Job Manager**

**Double click** on the “CCS Training Company” to access the Jobs in the company.

The job manager generates a new header and new job automatically. You may create up to 99 jobs within a company that can be copied, renamed, deleted and backed up using the Job menu or using the Right-click Menu.
2.5 **Create a new Job**

**Do This**

Click the Job > New Job menu

![Job Manager: Jobs in company 'CCSTraining Company']

Edit the job name to read "Waste Water Treatment Works" and then click OK.

![New Job Properties]

**Note:** You may designate a Job Code and Password for your job

![Job Manager: Jobs in company 'CCSTraining Company']

Open the job by double clicking on the job or by clicking Select.
2.6 **Recover the CCS Demo Job**

From the Job Manager click *Job > Backup/recover job > Recover into a NEW job > from file*

Recover the Ventshaft and Substation Contract using the following directory on the Candy Installation CD *<CD Drive>/FSCOMMAND/Demo Jobs/Ventshaft and Substation Contract*
Click **Yes** to confirm.

Click on **Select** to access the Ventshaft and Substation Contract.
2.7 **System Registration**

To use Candy, the system must be registered with CCS.

If your system has not been registered, the system registration dialogue box will be displayed as a broken key.

The registration process is completed telephonically using a set of unlocking codes. If the system has been registered, the job selector will be displayed.

CCS will allow prospective clients a free trial licence to assess the software.

Please contact the nearest CCS office:

**South Africa**
Tel: 086-11-CANDY (RSA only)
Tel: +27 12 643 0380 (International)

**Australia**
+64 212 833 822

**India**
Cochin: +91 484 411 4141

**New Zealand**
Auckland: +64 212 833 822

**Portugal**
Lisbon:+351 (91) 724 1305
Porto:+351 (91) 861 9171

**United Arab Emirates (Dubai)**
Dubai: +971 4 2676115/2676490

**United Kingdom** Bournemouth: +44 (1202) 582 653
Glasgow: +44 (1505) 506 118
Chapter 3. Candy User Interface

The Candy user interface consists of four main sections namely: Title bar, Application Tabs, Application Menus & Toolbars.

3.1 Candy Navigation

- **Candy button**: To select the job manager, system settings and to exit the software
- **System toolbar**: Job manager and system settings toolbar buttons
- **Title Bar**: Displays the company and job you are working in
- **Candy version**: Displays the software version installed on the computer and displays the system information
- **Application tabs**: To select the Various Candy applications
- **Application menu**: Displays the menus of the application selected
- **General menu**: Menu for Utilities & Help including telephone list, daily dairies, card games, help files, licence registration, support information & a website link to Update the Candy version
- **General toolbar**: Displays general tool buttons for use on all applications
- **Application toolbar**: Displays shortcuts specific to the application selected. This toolbar changes when a different application tab is selected
- **Customise Toolbar**: To select the toolbar buttons displayed on the different toolbars
3.2 **Document Navigation**

**Do this**

To add the Standard Bill of Quantities Document to the Document Manager click on Documents->**Estimating Documents** then click **New** and Select 1.1 **Standard Bill of Quantities** and confirm then click **Open** to open the document.

---

**Document Title**
The name of the document

**Split screen buttons**
Resizes the document to the top or bottom half of the screen.

**Escape**
Go back to the previous menu.

**Document menu**
The menus available for this document

**Document toolbar**
Tool buttons for larger or smaller screen fonts, line deletion, find & replace, export to Excel and print screen.

**Select all records**
Selects all records in the Bill of Quantities.

**Function Buttons**
These buttons relate to the function keys on the keyboard. Namely; Calculate (F12), Worksheet (F11) and Go to Page (F10).

**Record selector**
Selects the entire record. Right click to display the record menu

**Column Selector**
Selects the entire column. Right click to display the column menu

**Page Navigation Buttons**
Scrolls between different pages namely; first page, previous page, next page and last page of the bill.
3.3 **Right click menu functions**

The menu functions in Candy are context sensitive; therefore, specific tasks can be performed directly on the document’s cell, record, or column by right clicking for additional options.

**In a cell:**

![Right click menu in Candy](image1)

**In a record selector:**

![Right click menu in Candy](image2)
3.4 Customising the System

The (brown hammer) icon or right-clicking on the Candy desktop enables desktop customisation.

Fonts
Change the font, style and size for various areas of the system. You may find that the view is limited in a document, for example the Bill of Quantities, and may need to adjust your fonts later.
**Documents**

Colours can be selected for cursors and input fields on documents and level headings.

![Image of system settings for documents and line colours]

**Tool buttons**

Frequently used shortcuts keys can be activated here by applying ticks or removing ticks.

*Do this:*

Select utilities tool buttons to activate the system tools.

![Image of tool buttons window]
Folders and Paths

This sheet holds various folder paths used by Candy. The paths may be entered manually or located by using the Browse button.

The Candy system can be configured on the network by setting up the folders and paths. The following paths can be set as below:-

**Common backups** – to set the path to the Common folder used by all the users wishing to backup data on the organisation’s network. (The backed up data can be recovered by other users)

**Archived backups** - to set the path to the Archived folder for the individual user who wishes to backup data on the organisation’s network. (The backed up data can only be recovered by the individual user)

**Candy network masters** – To set the path for a master network company enabling users to access the master library job centrally

**Microsoft Excel** - the path pointing to Excel for exporting Candy data directly to Excel.
3.5 **Keystrokes, Icons and Mouse Functions**

**Mouse Functions**

**Note:** This table assumes that the mouse buttons are configured for a right-handed user.

<table>
<thead>
<tr>
<th>Mouse action</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left-click</td>
<td>On an Active Document - moves the cursor line to and positions the editing cursor at the mouse pointer. On an Inactive Document - Turns the document Active and acts as above.</td>
</tr>
<tr>
<td>Right-click</td>
<td>On an Active Document, calls up the context menu.</td>
</tr>
<tr>
<td>Double Click</td>
<td>Fetch another document, i.e.: Double Click on a Net Rate calls up the Worksheet.</td>
</tr>
<tr>
<td>Row Record + Left-click</td>
<td>Select a line of data for Dragging and Dropping.</td>
</tr>
<tr>
<td>Row Record Shift+ Left-click</td>
<td>Marks the Start and End of a Range of records for Dragging and Dropping.</td>
</tr>
<tr>
<td>Alt+Left-click</td>
<td>Set an Alternate document.</td>
</tr>
</tbody>
</table>

**Keystrokes**

This is a list of the Editing and Cursor Movement Keystrokes, with a brief explanation of the function, and the equivalent Icon if available.

**Note:** Normal Windows shortcut keys can be used e.g. Ctrl C – Copy, Ctrl V – Paste etc.

- Shift+Esc(ape) Returns to the job selector
- Esc(ape) Returns to the previous menu
- Ctrl+Tab Moves the document currently on top to behind all other documents.
- Ctrl+Insert Inserts a new line at the cursor position
- Ctrl+Del Deletes the current line at the cursor
- Tab Moves the cursor forward to the next Field. Shift+Tab moves the cursor backwards.
- Home Moves the cursor to beginning of the field
- End Moves the cursor to the end of the field
- Ctrl + > Move to the next page
- Ctrl + < Move to the previous page
<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Page Up</td>
<td>Takes you to the first line of the first page of a document</td>
</tr>
<tr>
<td>Ctrl+Page Down</td>
<td>Takes you to the first line of the last page of a document</td>
</tr>
<tr>
<td>Ctrl+Enter</td>
<td>Split the line at the cursor position</td>
</tr>
<tr>
<td>Backspace</td>
<td>Deletes one character at a time</td>
</tr>
<tr>
<td>Ctrl+Backspace</td>
<td>Deletes one word at a time</td>
</tr>
<tr>
<td>Ctrl+Left-arrow</td>
<td>Bubble Up - move the current line up</td>
</tr>
<tr>
<td>Ctrl+Right-arrow</td>
<td>Bubble Down - move the current line down</td>
</tr>
<tr>
<td>Ctrl+Up-arrow</td>
<td>Collapse level headings (to hide all text under headings)</td>
</tr>
<tr>
<td>Ctrl+Down-arrow</td>
<td>Expand level headings (to show all text under headings)</td>
</tr>
<tr>
<td>Shift+Ctrl+Down-arrow</td>
<td>Opens all sub headings within the cursor position heading</td>
</tr>
<tr>
<td>Shift+Ctrl+Up-arrow</td>
<td>Closes all sub headings within the cursor position heading</td>
</tr>
<tr>
<td>Ctrl+Space Bar</td>
<td>Open all headings completely</td>
</tr>
<tr>
<td>Shift+Ctrl+Space Bar</td>
<td>Close all headings completely</td>
</tr>
<tr>
<td>Ctrl+R</td>
<td>Pick Up the current Line</td>
</tr>
<tr>
<td>Shift+Ctrl+R (Ctrl+D)</td>
<td>Drop (insert) Lines picked up using Ctrl+R at the current line</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Turn current line to UPPERCASE letters</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Turn current line to lowercase letters</td>
</tr>
<tr>
<td>Ctrl+T</td>
<td>Turn current word to Sentence case</td>
</tr>
<tr>
<td>Ctrl+K</td>
<td>Copy the Field above</td>
</tr>
<tr>
<td>Ctrl+J</td>
<td>Copy the Field above and moves cursor down one line</td>
</tr>
<tr>
<td>Alt+Del</td>
<td>Close the active Document.</td>
</tr>
<tr>
<td>Shift+Alt+Del</td>
<td>Close All Documents.</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo.</td>
</tr>
</tbody>
</table>

**Note:** As soon as the cursor is moved off the line, the line is stored and the undo button will not function.
Chapter 4. Importing the Bill of Quantities

A bill of quantities can be created by:

- Typing the Bill in manually
- Copying items from a previous Bill of Quantities, which is called a “Master”.
- Importing an entire Bill from an external file, e.g. Excel, or WinQS, provided by the client or QS

We are going to create the Bill of Quantities below by importing these Bill pages from Microsoft Excel.
4.1 **Access “Waste Water Treatment Works”**

*Do this:*

Return to the Job Manager, click on “Water Waster Treatment Works” and click on **Select** to access the job.

4.2 **Setting up a new estimate**

*Do this:*

Click the **Bill Prep > Bill Importing**
The New Estimate setup dialog appears when accessing the job for the first time. The estimate setup dialog is used to select a Master and entering the tender details.

**An explanation of Masters**

A “Master” is simply a library, another previous job from which bill items, resources, definitions and other information may be copied into the current job.

Any job may be used as the Master for the current job. Typically, an estimator will create a special Master, which will be the source of standard information for use in other jobs.

Proper use of Masters can have a major impact on the speed of creating and pricing an estimate.

In this instance, there is no previously priced job that can be used as a Master for pricing “Waste Water Treatment Works”.

**Do this:**

Since there are no previous jobs and no Master, ensure that the **Master selection** checkbox is not ticked then click **OK**.
4.3 **The Bill Importer document**

A Bill document exists in Candy for importing Bills. The Bill Importer document contains all the tools required to import and format the Bill.

There are no bill items at present. Copy a Bill from an Excel spreadsheet and paste it into this document.
4.4 Importing a BOQ from an Excel spreadsheet

Copying all the Bill data in the Excel spreadsheet to the clipboard

Do this:
Open the Excel file and select all the data using **Ctrl-A** or using the global button.

Right Click on the selected range and **Copy** (or Ctrl-C) to copy the Excel data to the clipboard.
Pasting the bill from the clipboard
Return to Candy. On the Bill Importer document, and choose

**Tools > Import Bill > Paste bill from clipboard** (or Ctrl-V)
The Column Selection dialog box appears. Identify the Item number, Description, Unit and Quantity. Click the item in the list on the left that identifies the column under the big grey arrow.

The arrow will move to the next column. Click the button when completed.

The bill import indicates that 18 items were imported.
The Bill Importer document shows the imported items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Unit</th>
<th>Bill Qty</th>
<th>New Page N°</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Clear site</td>
<td>m²</td>
<td>2,000</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>Remove top soil 150mm thick</td>
<td>m²</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Excavate bases 0 - 2 m deep</td>
<td>m³</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Excavate foundations 0 - 2 m deep</td>
<td>m³</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Excavate for Pit or Sump</td>
<td>m³</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Excavate for retaining wall footings</td>
<td>m³</td>
<td>300</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>Excavate for foundations 4 - 6 m deep</td>
<td>m³</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Excavate for foundations 6 - 8 m deep</td>
<td>m³</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td><strong>H.D BOLTS AND MISCELLANEOUS METALWORK</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Supply, place and cast into position, hot dip gavanised H.D. bolts</td>
<td>No.</td>
<td>250</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>M20 HD bolts in lengths ex. 750mm and ne 1000mm overall length</td>
<td>kg</td>
<td>6,440</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>M30 HD bolts in lengths ex. 1250mm and ne 1500mm overall length</td>
<td>No.</td>
<td>110</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>The following in galvanised mild steel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>6mm thick chequer plate duct covers cut to suitable lengths on site</td>
<td>m²</td>
<td>660</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>40x6mm flat section welded to L-section</td>
<td>kg</td>
<td>1,570</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>40x6mm flat section lug 180mm long</td>
<td>no</td>
<td>750</td>
<td></td>
</tr>
</tbody>
</table>
Repaginating the bill

The original Bill contained two pages; our imported bill consists of one long bill page. Page Break marks need to be set in the Paginate column for all the items starting on a new Bill page.

Repaginate the Bill to see the page breaks. Note that all metalwork items must be on page 2.

**Do this:**
To set a page break on **H.D. Bolts and miscellaneous metalwork** right-click in the paginate column for this item, and choose **Set page break marks**

Click **Yes** to the confirmation dialog.

The “+” represents the page break mark.

Repaginate the bill. Right click on the New Page No. column header and select **Paginate the Bill**
Importing the Bill of Quantities

Click **OK** to confirm the repagination...

...and click **OK** to confirm the acceptance of the pagination process.
The bill has now been imported and the corresponding/required page breaks set. Now close this document.
4.5 **The Estimating Document Manager**

The Bill of Quantities can be viewed, edited and priced using various layouts in the Estimating Document Manager.

**Do this:**

Open the Bill Document Manager by clicking on *Documents > Estimating Documents*.

The Document Manager contains a standard set of data and column layouts that may be copied, customised or renamed. The layouts in the Document Manager are universal to all jobs in Candy. Any changes made to a document layout will be reflected in all jobs.
4.6 Changing comments to section headings

Section headings
In a Candy Bill a hierarchy of headings can be created, allowing easier navigation of the Bill by opening and closing sections and generating summary pages in reports.

All non-Bill items imported from an external file will be marked as comments. Many of these can be converted to meaningful headings to improve the readability of the Bill.

Do this:
Open document 1.1 Standard Bill of Quantities and change the first comment (C) of each page to a Level 1 heading by typing the number 1 in the Level column “L” (the first column). As the level changes, the line colour will change to the colour for that level.

Notice that both pages of the bill are shown. The Candy bill can be displayed in a multi-page mode (like this), or a single page mode, where only one page is visible at a time.

Do this:
For simplicity in the next exercises, from the Bill document menu, click View > Single page bill to get the one-page-at-a-time mode. Now close the Bill document.
Chapter 5. Pricing the Bill Items

The Bill items can be priced using **plug rates**, **split rates**, or **worksheets**. This chapter will cover pricing in Plug and Split rates. The pricing type and other item information are shown in the Attributes column. Add this column to the Bill document.

**Do this:**

Open the Estimating Document Manager again (**Documents > Estimating documents**), choose **1.1 Standard Bill of Quantities** and then click the button to change the column layout.

**Note:** The document manager contains different layouts, and **Not a Different Bill of Quantities**.

The column pick list

This type of dialog below is called a **pick list**. Columns can be added from the left-hand **Available** list to the right-hand **Selected** list. Notice that the **Available** columns are grouped into headings. Double clicking on a heading opens or closes it.

Open section **2 Bill Items**. Choose column **2.6 Attributes** and use the arrows to move the column to the **Selected** list.

The column order can be changed with the and arrows. Move the **Attributes** column to below the **Units** column and click to store the new column layout.
5.1 Plug Rate Pricing

Plug rate pricing is done by simply plugging in a rate in the Net Rate column for each item. In the Estimating Document manager, open 1.1 Standard Bill of Quantities. Note the U in the new Attributes column shows that all the bill items are Unpriced.

<table>
<thead>
<tr>
<th>Item</th>
<th>Bill description</th>
<th>Unit</th>
<th>Attribute</th>
<th>Bill qty</th>
<th>Rate</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Clear site</td>
<td>m2</td>
<td>U</td>
<td>2,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Remove top soil 50mm thick</td>
<td>m2</td>
<td>U</td>
<td>300</td>
<td>Not priced</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Excavate basos @ - 2 m deep</td>
<td>m3</td>
<td>U</td>
<td>100</td>
<td>Not priced</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Excavate foundations @ - 2 m deep</td>
<td>m3</td>
<td>U</td>
<td>200</td>
<td>Not priced</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Excavate for Pit or Sump</td>
<td>m3</td>
<td>U</td>
<td>150</td>
<td>Not priced</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Excavate for retaining wall footings</td>
<td>m3</td>
<td>U</td>
<td>300</td>
<td>Not priced</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>Excavate for foundations 4 - 6 m deep</td>
<td>m3</td>
<td>U</td>
<td>300</td>
<td>Not priced</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Excavate for foundations 6 - 8 m deep</td>
<td>m3</td>
<td>U</td>
<td>500</td>
<td>Not priced</td>
<td></td>
</tr>
</tbody>
</table>

Price item “A Clear Site” by entering 10.00 in the Net Rate column.

Every bill item will require a Trade Code when pricing.

No Trade Codes currently exist in this job. Candy will allow the defining of codes at this stage.

Click Yes to define a new trade.

In the New Trade dialog, enter an E for the code and the description as Earthworks and click OK to add Earthworks trade to the Trade Codes list below.

Allocate the new Earthworks trade to the Clear site bill item by selecting Earthworks and

34
Note that $PT$ is displayed in the Attributes column indicating that the Item now has a Plug rate and a Trade allocation.
5.2 Trade Definitions

The Trade codes can be defined in the definitions menu. Access the definitions menu by clicking on the blue hammer on the Candy Toolbar.

Select 1.1 Trades. Note the Earthworks trade was added when pricing Clear site. Define the remainder of the trades by entering an Alphabetic letter as a trade code and a description. A maximum of 52 Trades may be defined.
5.3 *Split rate pricing*

Split Rate pricing must be done in a Split Bill of Quantities document that shows the Net split rate columns. Open the document manager again and open **1.5 Split Rate Pricing**.

![Estimating document Manager](image)

This warning will appear.

The Split Bill of Quantities document cannot display the Net split rates because no **Resource types have been defined yet**. Resource types need to be defined. All definitions and settings for Estimating are to be found in the Definitions and Settings dialog.
Do this:

Click *Main > Definitions and Settings* (or 📊) and choose **1.2 Resource Types**. Type in these Resource types. Up to 9 resource types can be defined.

Go to the document manager again, customise document 1.5 Split Rate Pricing by adding in the Attributes column as before, and then open the document.

Note that the document can now display the newly defined Net Split Rate columns.
Price Item B using split rates

Remember to first allocate the Trade code by typing in the trade code “E” in the Trade code column.

Now enter 2.00 in Labour Split Rate column and enter 8.00 in Plant Split Rate column.

Note the ST in the Attributes column indicating that the Item has a Split rate and a Trade.
Chapter 6. Pricing using Worksheets

Note: Pricing using plug rate and split rate is not recommended because it only generates financial information for the job. Pricing using Worksheets is the ideal method because it is priced from first principles using resources. Candy can be used to its full potential to generate both financial and engineering information.

An explanation of Price Codes

The Price Code’s **function** is to deal with the unit price of a bill item. To rate a bill item, a Price Code is entered against it and the bill item adopts the rate from the Price Code regardless if it was generated, by plug rate, split rates or worksheet).

The Price **Code** can be up to 8 alpha-numeric characters in length. The first character of the Price Code must start with a Trade Code letter and the rest of the code is entirely up to you.

Note that the Price Code has its own **Description**. The description of the bill item is totally independent of the Price Code description. Therefore, two items in the bill with different descriptions can be priced using the same Price Code. Conversely, two items in the Bill with the same description can be priced using different Price Codes and therefore have different rates.

6.1 **Price Codes**

**Do this:**

Open the Document Manager and customise document **1.2 Pricing Bill** by adding in the Attributes column, as before but at the end of the layout, then open the document.

This layout contains columns relating to the Price Code.

Candy automatically created the Price Code for the first priced items.

**Example:**

The Bill item **Clear site** on page 1 has a Price Code E00002 with a rate of **10.00**. By allocating, the same Price Code to any other bill items will price them using the Price Code rate, effectively speeding up the pricing process. Pricing using Worksheets is made a lot easier if Trade codes are initially allocated to the relevant bill items.
6.2 **Trade code allocation**

Allocate trade codes to individual bill items

*Do this:*  
In item C’s Trade code field, right-click and select *Allocate Trade Codes*.  
Select *Earthworks* and confirm.

Allocate trade code to a range of bill items

*Do this:*  
Click on item D in the trade code column and shift-click item H in the trade code column. This highlights the records in the selected range.  
Right-click on the selected range in the Trade code column and choose *Allocate Trade codes* from the menu.
Select *Earthworks* and confirm.

Click on **OK** to accept the allocation of the Trade Codes

The Earthworks Trade code has been allocated to all items on page 1.

Using the same method, allocate trade code M to the metalworks bill items on Page 2.
6.3 Pricing using Worksheets

Having allocated Trade codes pricing items are easier using worksheets. Price item 1/C. The worksheet allows for resource-based pricing. The worksheet may contain up to 200 calculations.

**Explanation of Simple Resources**

For worksheet pricing, we need to create some resources. The Resource Types have already been defined, which categorise simple resources. For example, Labour resources fall into the \(L\) resource type and material resources, such as stone, fall under the \(M\) type.

**Do this:**

Place the bar cursor on item 1/C and click the **Worksheet** button at the bottom of the document.
Create a resource within a Worksheet

Do this:
Create a resource by right clicking on a blank line in the worksheet. Choose *Edit/New resource* from the menu.

Enter the details for the new resource in the Resource Input dialog as shown below.

Click **OK**.
The resource description and rate is now displayed on the worksheet. The resource is 5.25/hr and the bill item is per m³. Enter the calculation “$9\text{hrs/day}/1.5\text{m}^3/\text{day}$.” The calculation is entered on the worksheet as it would be written on paper (format free).

### Store Worksheet Modes

The worksheet has to be stored to reflect the net rate in the Bill. The Store modes available are:

- **Store & next worksheet** – Store the current worksheets and displays the next bill items worksheet
- **Store & return to document** – Store the current worksheet and return to the bill
- **Store & next unpriced worksheet** – Store the current worksheet and displays the next unpriced bill items worksheet.

To display the 3 options click on the or hold down the shift key and click on the store worksheet function button **Store & next w/s**.

Click on and select the option to Store & return to document

Store the worksheet by clicking on **Store worksheet**.
Note that *WT* is displayed in the *Attr* (attributes) column indicating that the item has a Worksheet and a Trade.

**Create a resource directly on the Resource List**

*Do this:*  
Click on the Resource List icon to display the Resource List. Resource Code 200 Unskilled Labour (all in) was added when pricing Item C.

---

Go to a blank line and enter a new resource called “Charge hand”.

---

### Resource List

<table>
<thead>
<tr>
<th>L</th>
<th>T</th>
<th>Code</th>
<th>Description</th>
<th>Unit</th>
<th>Final rate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>200</td>
<td>Unskilled Labour (All in)</td>
<td>/Hr</td>
<td>5.25</td>
</tr>
<tr>
<td>L</td>
<td></td>
<td>210</td>
<td>Charge Hand</td>
<td>/Hr</td>
<td>7.60</td>
</tr>
</tbody>
</table>
Price Item 1/D using a worksheet

_Do this:_
Right click in the rate column of item 1/D and select the display worksheet option

Insert an existing resource in the Resource list using the right-click menu

_Do this:_
Open the Resource List by right clicking on a blank line in the worksheet. Choose *Resource list* on the menu.
Select resource **200 Unskilled Labour (all in)** and confirm.

Add resource **210 Charge Hand** using the same method.

The worksheet now contains the resources, but no calculation for the rate.

Now enter the following calculations against each resource in the worksheet.

The worksheet contains two calculations. To display the total of both calculations, place an equals sign "=" on a new line against the left margin and press enter. Notice the total for these calculations at the end of the line.

Click **Store worksheet**.

Item 1/D is now priced using a worksheet.
Complex Resources

Explanation of Complex Resources
It is tedious to bring the Unskilled Labour and Charge Hand and to combine them every time you price an Excavation item in the Bill of Quantities. Similarly, pricing concrete, it would be tedious to have to combine the sand, stone and cement in the correct portions for each bill item.

Candy allows you to combine these Simple Resources to create a Complex Resource. When an excavation item need to be priced, the excavation team complex resource need to be brought into the worksheet; similarly, when a concrete item need to be priced, the concrete complex resource need to be brought into the worksheet for the bill item.

Higher-level complex resources can be made from other complex and simple resources. Level 9 is a very basic complex resource, which can be made of only Simple resources, a Level 8 resource can be made of level 9 and Simple resources, a Level 7 resource can be made of Level 8, Level 9 and Simple resources, and so on in a hierarchy of Complex Resources.

This diagram shows the principle of the hierarchy of Complex Resources:

A Complex Resource is created by assigning a level number between 1 and 9 in the Resource List type column.
**Do this:**
Enter the new complex resource **220 Hand Exc. team (1C + 2L)** in the resource list.

Complex resources must be priced using a worksheet. With the cursor on the **220 Hand Exc. team (1G + 2L)**, click on the **Complex worksheet**.

**Insert a resource into a worksheet by typing in the resource code.**

**Do this:**
Type in the resource code 200 against the left margin of the worksheet and press Enter. Do the same to insert resource code 210. Enter the following calculations to calculate the daily cost of the Hand Exc. Team.

Remember to change the store mode to Store & Return to document and store the Complex Worksheet.
Now the Resource List shows two Simple Labour resources and one Level 9 Complex Resource.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Unit</th>
<th>Final rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>L200</td>
<td>Unskilled Labour (All in)</td>
<td>/Hr</td>
<td>6.26</td>
</tr>
<tr>
<td>L210</td>
<td>Charge Hand</td>
<td>/Hr</td>
<td>7.60</td>
</tr>
<tr>
<td>0200</td>
<td>Hand Exc Team (10 + 2L)</td>
<td>/Day</td>
<td>162,800</td>
</tr>
</tbody>
</table>

Insert a resource into a worksheet using the Drag & Drop method

**Do this:**

Open the Worksheet for the bill item 1/E "Excavate for Pit or Sump". To make it easier to perform these operations, move the Bill, Worksheet and Resource Lists into the positions as displayed below.

Now click on the anchor in the Worksheet title bar to make the worksheet always appear in the same position and size.
Click and hold down the mouse button on the record selector for the Hand Exc Team (1G + 2L), in the Resource List and drag & drop the resource onto the worksheet.

Enter the following calculation to calculate the rate per m³.

Click Store worksheet
Copying Worksheets using the drag & drop method

The next item 1/F has the same rate as item 1/E. The worksheet can be copied from Item 1/E into Item 1/F using the drag and drop method.

**Do this:**

Open the Worksheet for the bill item **1/F Excavate for retaining wall footings**.

From the bill document click on the record selector bar for bill item **1/E Excavate for pit or sump** and drag it into the worksheet for **Excavate for retaining wall footings**.
The worksheet calculations for Bill Item 1/E is copied into item 1/F worksheet. There is no need to input the complex resource or the production as this information was copied from the previous Bill item 1/E.

Click **Store worksheet**.

**Pricing Items 1/H and 1/G**

The last 2 items on page 1 are deep excavations and will therefore require an Excavator. Create a new complex resource for an Excavator including the diesel and use it to price the bill items.

**Do this:**

Open the resource list and create Simple Resources for the Excavator and Diesel. Remember the Simple Resources must be categorised into the correct Resource Type, i.e. Excavator into Plant (P) and Diesel into Material (M).

Now create the Complex Resource for Excavator (Wet). Remember that the Complex Resource must have a Level number between 1 and 9 in the Resource Type column.
Price the Complex Resource “CAT 215 Excavator (Wet)” by clicking on Complex worksheet and use the following resources and calculations:

Use any one of the methods above to insert resources into the worksheet: Click Store complex.
Price Item 1/G using a worksheet

Now Item 1/G can be priced from first principles using the complex resource Excavator (wet) and 3 Unskilled Labourers.

Do this:

Open the worksheet for item 1/G to price it using the following resources and calculations.

Click ![Store worksheet](image)

Copy worksheets using the Insert a w/s button

Item 1/H is similar to Item 1/G, the only difference is the excavation depth. To save time, copy the worksheet information from Item 1/G into Item 1/H.

Open the worksheet for Item 1/H. Click ![Insert a w/s](image)

Use the “spinner” up and down arrows to scroll through the available Price Codes.

When Price Code E00008 appears, click ![OK](image) to copy the worksheet information.
Adjust the production to **400m³/day** to compensate for the deeper excavation and then store the worksheet.

All the items on page 1 should now be priced and the page total should be "**69,176.00**".
Chapter 7. Worksheet Tools and Shortcuts

Various tools and shortcuts in the worksheets have been developed to speed up the pricing process.

Item 1/H will be used to demonstrate the various worksheet tools.

7.1 Applied Factor "#"

Do this:
With the cursor on Item 1/H, click Worksheet.

Note that many lines of the worksheet share a common production of 400m³/day, rather than entering the production on each calculation line; we can introduce an applied factor.

Use the hash sign # to introduce an applied factor.

Do this:
Place the cursor on the top line of the worksheet and insert a line by pressing Ctrl-Insert.

Now type a # sign, delete the production from the following 2 calculation lines and then enter on a new calculation =/400m³/day. …and press Enter.

The words APPLIED FACTOR appears. The result remains the same at 6.54.
7.2 **Local Variables**

Local variables are defined and used on a worksheet using the square brackets “[]”.

**Do this:**

Use Ctrl-Insert to insert a few blank lines at the top of the worksheet. Enter the following variables.

```
[BUCKET]=0.5  Bucket size
[CYCLES]=120  Cycles per hour
[HOURS]=20   Hours per day
[EFFIC]=0.6  Efficiency
[BULK]=1.4   Bulking factor

[PROD]=([BUCKET]*[CYCLES]*[HOURS]*[EFFIC]/[BULK])  PRODUCTION
```

Now press enter on the production calculation line and message confirming the calculated value will appear.

Click **OK**.
Calculations are detailed by starting a calculation line with a question mark “?”.

To display the calculated value of production on the worksheet type the following “?[PROD]” and press Enter.

Now delete the 400m³ production on the applied factor line and replace it with [PROD].

### 7.3 Comments

Worksheets can be documented by leaving one blank space on the left of the worksheet followed by the relevant comment.

Add +15% to the applied factor line and then type a comment 15% for overbreak.
Chapter 8. Subcontractor Adjudicator

The metalwork items on page 2 will be subcontracted. The Subcontract Adjudicator will be used to adjudicate and select the most competitive subcontractor.

8.1 Subcontract Package Manager

The subcontract package manager is used to create, delete, copy, rename and backup the subcontract packages.

Do this:
Click on Adjudicators > Subcontractor adjudication > Subcontract packages to access the Subcontract Packages Click on New to create a new package for Metalwork.
8.2 **Subcontract Package**

**Explanation of the Subcontract Package**
The rates of up to twelve subcontractors can be allocated to a range of bill items representing a package of work. The quotes can be compared and adjudicated. The cost (net) or selling rates of the selected subcontractor can then be exported to the bill.

**The Bill columns**
The first four columns on this document identify the items from the bill - page, item, unit and billed quantity. An 'N' in the next column indicates if an item has a note recorded against it.

**The subcontract columns**
The remaining columns provide for twelve sets of quotations from subcontractors. Each set is given a Name, a Factor (discount, etc.), and a Currency code (if applicable). The subcontractor's rates are entered in the rate or amount column. If a subcontractor has included the cost of a certain item in other rates, a rate of zero should be entered. If he has declined to price an item, the rate column should be left blank. The Pricing code and net rate, if there is one, from the bill are shown in the last two columns.

**Linking to the bill**
Items may be imported directly from the bill (or typed in). For the description to be displayed and also to permit rates to be transferred back to the bill, it is necessary for the items to be linked. This occurs automatically when items are imported, but must be done individually for items entered manually. The link is created by looking up the page/item combination in the bill. Once a link is established, changes made to the Pricing code and item number on the bill is reflected in the package. Deleting the item on the bill breaks the link but does not delete the item in the package. Unlinked items are marked with a U in the item column.

A calculated amount equal to Rate x Factor x Currency factor x Quantity is displayed against each rate.
Do this:
Click on **02 Metalwork** to open the Subcontract package.

The Subcontract package allows for a maximum of 12 subcontractors to be adjudicated. Bill items from a section in the Bill may be imported into the Subcontract Package.

### 8.3 Importing the bill items in the Subcontract Package

**Do this:**
Click on **Tools > Import > Import Bill items by Page & Trade**

Importing may be done using a page range or trade. In Chapter 6 the trade code “M” was allocated to all the Metalwork items. Therefore, check the option **Select Trades** to import by trade.

The Multiple trade selector appears.
Select **Metalwork** Trade and confirm.
A message appears confirming the number of items imported.

Click **OK**.

### 8.4 Entering the Subcontractor Rates

All the metalwork items have been imported into the Metalwork package. First, enter the Subcontractor names in the subcontractor name field and then enter the subcontractor rates.

Note that AR Metalfix has not priced item 2/E, so leave the rate as blank. A zero rate would indicate the item has been included. Smith Metalworks has given a 5% discount; therefore, a factor of 0.95 is entered in the factor field below the subcontractor’s name.

Note that Smith Metalworks rates are not discounted but the amounts are discounted.
8.5 **Subcontract adjudication**

*Do this:*
To adjudicate the subcontractors click on **Compare quotes**

To compare all three subcontractors, set the slider to 3.

Leave the preferred make-up rate as **none** and confirm.

The common total is the totals for the subcontractors for those items that have all been priced.

There will be a balance if any of the subcontractors has not priced and item.

The maximum make-up is calculated using the maximum rates from the other subcontractors who have priced that item.

The minimum make-up is calculated using the minimum rates from the other subcontractors who have priced that item.

AR Metalfix has an un-priced item; therefore, the column total is not a fair comparison.

The adjudication can now be used to make a fair comparison between AR Metalfix's quote and the other 2 subcontractors quote using the maximum totals (worst case scenario) and minimum totals (best case scenario).

Click **OK** Transferring the Subcontractors rates to the bill.
8.6 Transferring the Subcontractors rates to the bill

The rates from Smith Metalworks will be used to price the metalwork bill items on page 2.

**Do this:**
Right-click on the Smith Metalworks Rate Column and choose *Rates to Bill > Send subcontractor rates to bill* or choose the Rates to bill button at the bottom of your bill.

To Transfer the rates from the subcontractor adjudicator to the bill item worksheets a simple resource is required with a rate of one, a metalwork subcontractor resource has never been created and one will be created during the transfer process. The subcontractor rates can be added to the worksheet using Amend or Overwrite. Enter the resource code 900 in the resource code field, select *Amend* and click on **OK**.
Select resource type **S** in the type field and enter the Unit as **Sum**. Click **OK**.

A message appears confirming the number of rates transferred. Click **OK**.
8.7  **Open the Bill to view the priced Metalwork items**

**Do this:**
Open document **1.5 Split Rate Pricing**

Note all the items on page 2 have been priced using Smith Metalworks' discounted rates.

Access the worksheet for Item 2/A and note that resource code 900 is displayed with the relevant subcontract rate from Smith Metalworks.

8.8  **Changing the Store Worksheet mode**

The Store worksheet button can be changed to perform three different functions.

**Do this:**
Click on the next to to change the store mode and choose **Store & next worksheet** on the menu.

When this button is used, it will store this worksheet and open the next bill items worksheet.
Chapter 9. Trade Totals Display & Resource Analysis

Now we can reap the rewards of our hard work. On screen analysis like a Trade summary and a resource analysis can now be viewed by the click of a button.

9.1 Trade Totals Display

Do this:
The job total by trade can be displayed by clicking icon.

Select the Bill Quantity

Select Net rates

The Trade Total Display is shown.

The subcontractor Net Amount of 90223.10 is the same total as calculated in the subcontract adjudicator for Metalwork when we displayed the Subcontract adjudicator results.
9.2 Resource Analysis

Resource analysis can be displayed on screen using one of the resource documents that displays the Bill Quantity Usage & Bill Quantity Usage value columns.

**Do this:**

Open resource document **1.4 Utilisation and value – billed quantity** from the resource document manager.

Click  

The bill usage columns is relative to the unit of the resource, i.e. 4598.31 hours of unskilled labour at 5.25/hr or a total allowable of 24141.13 to spend on this resource, similarly, there are 491.56 litres of diesel allowed on the job. Changing rates in the resource list will substitute the adjustments through all related worksheets and update the Net rate for each bill item.
Chapter 10. Mark Up

Up to now, the Net Rate for each bill item has been worked out. Mark up can now be added to our job to calculate the Gross Rate. Thus, the gross rate is calculated (Net + Applied Mark up = Gross)

Mark up can be added in various ways:
- Mark up all Trades
- Trade Mark up
- Individual Mark up

10.1 Mark up All Trades

Mark up the whole job by 10% using the Mark Up All Trades facility.

Do this:
Open Bill document 1.6 Markup Bill

Right-click in the Mark up column and choose General markup utilities > Markup ALL trades.
Enter a 10% mark up for all Trades and confirm by clicking **OK**.

Then click **Yes** on the dialog below:

Then click **OK** on the next dialog:
10.2 **Trade Markup**

Markup can be applied to Trades using the Trade Markup facility. Apply 5% markup to the Metalwork Trade.

Do this:  
Right-click in the Markup column and choose *General markup utilities > Trade markup.*

Adjust the Metalwork MarkUp to 5%
10.3 **Individual Mark up**

Return to the Bill and adjust the markup for item 1/A to 20% Mark up.

Click [Yes] to confirm the change.

The Markup type column now indicates what type of mark up has been applied.

The Metalwork items on page 2 have a 5% trade mark up.
10.4 *Trade Totals Display*

Do a trade totals based on the *Gross rate*

![Trade Total Display](image)

The Gross amount is displayed with the net split amounts for Labour, Plant, etc. The last column represents total markup amount.
10.5 Report Manager

All reporting in Candy is done through the Report Manager. A selection of pre-defined reports are available, any of which may be adapted to suit your specific requirements. The Report Manager consists of two tabs.

- **Job Reports**: These reports are only available to the current Job, and they are included as part of the Job backup.
- **My Reports**: These reports are available to all the jobs on your computer, so they are NOT backed up with Jobs.

Click on the Reports > Estimating Reports Manager, (or ![open Report Manager]), to open the Report Manager.

Try printing the following reports and select the various options to see the available reporting formats.

**Job Estimating Reports**

<table>
<thead>
<tr>
<th>Job Reports</th>
<th>Report Headings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Net Bill of Quantities Page Total</td>
<td>Bill of Quantity</td>
</tr>
<tr>
<td>Worksheets in Bill Order</td>
<td>Worksheet Reports</td>
</tr>
<tr>
<td>Bill resource Analysis</td>
<td>Resource Analysis Reports</td>
</tr>
<tr>
<td>Value Analysis</td>
<td>Analysis Reports</td>
</tr>
<tr>
<td>Pricing Check</td>
<td>Check and Review Reports</td>
</tr>
</tbody>
</table>
Chapter 11. Pricing Practical

**Do This**

Enter the following concrete items on page 3 of the Bill:

- A 20 MPa Concrete in foundations m³ 200 Not priced
- B 25 MPa Concrete in walls m³ 150 Not priced
- C 25 MPa Concrete in surface beds m³ 80 Not priced

Enter the following resources 510, 520 and 230 on the resource list:

- 230 Concrete Gang (1C+6L)

Price the complex resource 230 Concrete Gang (1C+6L)
Price the Bill Items from first principles using the following worksheets. Remember to first allocate the Trade Code "C" before pricing.

Item 3/A

Candy recognises the syntax "%waste" on a worksheet as long as there are no spaces between the +5%waste. The system will generate a wastage report.

Item 3/B

Item 3/C
Check the page total once you have completed pricing the items on page 3.

<table>
<thead>
<tr>
<th>Item</th>
<th>Bill description</th>
<th>Unit</th>
<th>Bill qty</th>
<th>Rate</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>20 MPa Concrete in foundations</td>
<td>m³</td>
<td>260</td>
<td>266.74</td>
<td>53,348.00</td>
</tr>
<tr>
<td>B</td>
<td>25 MPa Concrete in walls</td>
<td>m³</td>
<td>150</td>
<td>273.77</td>
<td>41,065.50</td>
</tr>
<tr>
<td>C</td>
<td>25 MPa Concrete in surface beds</td>
<td>m³</td>
<td>80</td>
<td>271.99</td>
<td>21,759.20</td>
</tr>
</tbody>
</table>
Chapter 12. Masters

Any previous job in Candy can be used as a Master from which Bill items, Worksheets and Resources can be copied. Typically an Estimator will create a library job. The effective use of masters can have a major impact on the speed of both input and pricing of an estimate.

In this Chapter, we will create a new job called “New City Industrial Development” and then use “Waste Water treatment works” as a Master to copy information into “New City Industrial Development”

Rules of a Master

- Only one master at a time
- No editing the master from the job
- Info flows from the master to the job
- The job’s info is always preferred

12.1 Master selection

**Do this:**

Click on the 🌐 to return to the Company & Job Manager.

Create a new job called “New City Industrial Development.”

![Image of Job Manager showing job selection]

Now open **New City Industrial Development** and open the Bill by clicking on the 📊 icon in Estimating.
Now click on **Main > Change Master**

Click the **button to browse for Masters.**

Click the **Companies/Jobs** button to browse for Jobs in the Company & Job Manager.

Choose **Waste Water Treatment Works** and **Select**.
Ensure that **Master selection** has been checked and click **OK** to confirm.

Master selection is now ticked and click **OK**.

Note that the Master is now displayed in the toolbar.
12.2 Definitions Menu

If a master is selected when creating a job, certain standard information is automatically copied from the Master. The trades and resource types were defined in the Master and have been copied into the jobs definitions.

Open the Definitions & Settings container with the blue hammer in the toolbar.

Select 1.1 Trades, and note that the trades were copied from the Master.

Select 1.2 Resource Types, and note that the resource types were copied from the Master.
12.3  **Copying bill Items from the Master**

Bill items can be copied from the Master into the job using **Drag & Drop, Copy and Paste** (Ctrl+C & Ctrl+V).

**Drag & Drop method**

*Do this:*

Hold the Shift key down and click the Bill Icon to display the Master Job. Notice that Master documents always use **blue text**.

Arrange the two documents by placing the Master Bill next to the job’s Bill as shown below, then drag & drop the **Clear site** record selector button from the Master into the Bill.

A new Bill item has now been generated together with its quantity and rate, by copying one from an old Job.
Drag & Drop many Bill items simultaneously

**Do this:**
Select items 1/B & 1/D from the master by Ctrl-clicking in the record button for each item.

Now click on the blue selected area and drag the items into job's bill, as before.

A range of items can be copied using Shift-Click rather than Ctrl-Click.
Copy & Paste (Ctrl+C & Ctrl+V)

Do this:
On item 1/E in the Master document, right-click on the record button to get the record menu and choose Copy.

Then, on a new blank line in the Bill, right-click and choose Paste.
### Copying multiple bill items

Multiple bill items can be copied from the master by selecting a range of items using the **shift click**.

Open the Master Bill and use **shift-click** on Items 1/F to 1/H to select the range. Right click and select **Copy**.

Open the Job bill and Right click and select Paste.
12.4  Pricing Bill Items using the Master

In most instances, the bill of quantities is received in an electronic format that can be imported into Candy. Once imported into Candy the bill items can be priced from a Master using the following methods.

**Do this:**
Enter the following concrete items on page 2 of your Bill.

Open document **1.2 Pricing Bill** and view page 2 of your Bill.
Do this:
Price the bill items using the Master by:

a. Typing in the Pricing code

Open the worksheet for item 2/B. Allocate trace trade C for concrete.

b. Using insert worksheet function

Select Master as the source, scroll through the Code and choose **C00021 - 25 MPa Concrete in walls**.

Click **OK**.
Change the production from 15m3/day to 10m3/day and click Store worksheet.

c. Right-click menu in the pricing code column

Right-click in the pricing code column for item 2/C

Choose Allocate Pricing code.

From the list of Master pricing codes select the code for 25Mpa Concrete in walls and confirm.
d. Double-click in the pricing code column
The same master pricing code list can be accessed by double clicking in the Pricing code column.
Price item 2/D by allocating a pricing code for 25Mpa concrete in surface beds.

Note:

**Shift - P** Opens the Master Price Code List

**Shift - R** Opens the Master Resource List

A Master can be changed by using the change master tool button.
Chapter 13. Post Tender Control

It has been established that: Net Rate + Applied Mark Up = Gross Rate

There is a third rate available in Candy called Selling Rate. This is an independent rate in that changes made to the Net Rate and Applied Mark up will not affect the selling rate.

13.1 Selling Rate

Do this:

Click on the to return to the Company & Job Manager and select the *Waste Water Treatment Works* job.

Open the Document Manager by choosing *Documents > Estimating documents*.

Select document *1.7 Selling bill of quantities*
Note the selling rate column on the right side of the document. Having priced a job and applied mark up, selling rates can be established by copying the Gross rate.

Right-click in the selling rate column header, select **Copy > Copy Selling rates from Gross**.
Select the option to **lock selling rates after copy** and click **OK**...

...and confirm the message.
Chapter 14. Value Engineering or Re-modelling

The site team can now re-visit each of the worksheets and adjust the productions to what they believe will be achieved on site. Alternatively, they may not even use the resources the estimator originally envisaged using and must, therefore, adjust the worksheets to reflect how they intend completing the job. They may obtain cheaper resource and sub contract rates. Let us assume the site team will purchase diesel for 2.5/ Litre instead of 3.00/ Litre.

14.1 Resource List

Open resource document 1.4 Utilisation and value – billed quantity

Adjust the diesel rate accordingly and click Calculate

Note that the Diesel allowable decreases from **1474.68** to **1228.90** representing a buying saving of **245.78**.
14.2 Trade Totals Display

- Do a Trade Totals Display on "Net" at $3.00/Ltr of Diesel.

Do a Trade Totals Display on Net at $2.50/Ltr of Diesel.

Original Net Amount – New Net Amount = (277,176.80 – 276,931.80) = 245.00 Saving
Original Material Net Amount – New Material Net Amount = (109,940.00 – 109,695.00) = 245.00 Saving

14.3 Bill of Quantities

Now return to page one of the Bill of Quantities

Do this:
Open document 1.7 Selling Bill of Quantities

Notice that the Net and Gross rates for Items G and H have been reduced as these items use the cheaper diesel in their make-up. Notice the Selling rates remained fixed and the calculated mark-up has increased in relation to the Selling.
Chapter 15. Summarising Resources into Cost and Group Codes

The Quantity Surveyor will require the total amount of money spent against each accounting cost code to reconcile against the budget to date generated in Candy. The Candy Cost Code must therefore be the same as the accounting/ledger code.

Similarly, the estimator would require the total amount of money to be spent with a particular supplier to negotiate the best possible bulk discount. The resources can be allocated to specific suppliers using the Candy group code to summarise the value to be spent against each supplier.

15.1 Resource list

The resource group and cost code columns must be displayed to allocate the codes to the resources.

Resource Document 1.5 Resource Group and Cost Code allocation display both group and cost code columns.

Do this: Open the Estimating Document manager > Resources tab

Resource document 1.5 Resource Group and Cost Code allocation is available as a template document.
Add a new template document by clicking on New

Select 1.5 Resource Group and Cost Code allocation and confirm

Open resource document 1.5 Resource Group and Cost Code allocation
15.2 **Defining the Cost and Group codes**

The Group and Cost codes must be defined before allocating them to the resources.

**Do this:**

Click on the button to access the definitions and enter the following Cost and Group Codes.

Choose 4.1 *Resource Cost codes (with)*

Choose 4.2 *Resource Group codes*

Click **OK** to close the Definitions
15.3 Allocating the Cost and Group codes to the resources

Return to the resource list and allocate the Cost and Group codes to the various resources. Cost and Group codes should only be applied to Simple resources, those resources that are bought and are defined with a letter in the resource type column i.e. M for Material, P for Plant. Applying a cost code to a complex resource such as 310, Cat 215 Excavator (Wet) would be incorrect as the cost would be captured against cost codes 360 and 401 representing the cost codes for plant and fuel respectively.

Filter Simple Resources

To make it easier to allocate cost and group codes to simple resources use the filter facility shown below.

Do this:

Click **Hide rejects** to view only the simple resources.
Allocate codes using double click

Double click in the Group code column for resource code 510 - 20/19 Mpa RMC

Select ABC Concrete Suppliers and confirm.

Do the same for resource code 520 - 25/19 Mpa RMC

Allocate codes using the right-click menu

Highlight both resource codes 200 and 210 using Ctrl + click and right-click in the cost code column.

Select Allocate Cost codes

Select 250 Labour and confirm.
Allocate the remaining cost codes using your method of choice i.e. Type in, Double Click or Right-click.

The filtered simple resources are currently being viewed.

Click **Abandon** to view the entire resource list.
15.4 Resource Analysis Reports

Bill resource Analysis with Group code summary

The Cost and Group code summary is available in the Bill resource Analysis (12) report.

Do this:
Open the Estimating report manager

Duplicate the Bill resource Analysis (12) report by right clicking on it and selecting Duplicate Report. Rename the report to Bill Resource Analysis with Group code summary.

Click Customise.

In the Summary part of the Bill Resource Analysis dialog, select Group Code.

Click OK.

Select Bill Quantity in the little menu, and confirm.
Print the report and preview the report.

**Page 1** reflects all the complex resources

<table>
<thead>
<tr>
<th>CODE</th>
<th>RESOURCE NAME</th>
<th>UNIT</th>
<th>P GROUP</th>
<th>RATE</th>
<th>UTILISATION</th>
<th>AMOUNT</th>
<th>Labour</th>
<th>Plant</th>
</tr>
</thead>
<tbody>
<tr>
<td>9 220</td>
<td>Hand Exc Yen (IC + 2L)</td>
<td>/Day</td>
<td>150.00</td>
<td>162.00</td>
<td>24,300.00</td>
<td>24,300.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>Concrete Of (IC + 6L)</td>
<td>/Day</td>
<td>214.96</td>
<td>7,007.96</td>
<td>7,707.96</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>315</td>
<td>CAT 215 Excavator (M/H)</td>
<td>/Day</td>
<td>3.64</td>
<td>9,746.20</td>
<td>7,537.31</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Page 2** reflects all the simple resources

...and **Page 3** is the Group Summary

The Group summary can be viewed at the bottom of the report. The value of **108,465.00** is to be spent on ABC Concrete Suppliers. The Undefined Resource Group of **145,463.42** represents those resources that do not have a group code allocated.
Bill resource analysis with Cost code summary

**Do this:**
Duplicate the *Bill Resource Analysis with Group code summary* report and rename it to *Bill Resource Analysis with Cost code summary*.

Click and select Cost Code as the Summary.

Click **OK**, select *Bill Quantity* and confirm.

Now print the report and preview the report.

*Page 1* reflects all the complex resources.
Page 2 reflects all the simple resources. Note that all simple resources should have a Cost Code allocated.

...and Page 3 is the Cost Summary

Note that plug and split rate totals are printed separately. It is impossible to allocate Cost codes to Split and Plug rates, therefore Split and Plug rates are considered bad practice. There is no Undefined Class codes, therefore all simple resources have a Cost code allocated.

Cost and Group Code Audit Reports

Analysis by Group/Cost report

This report will list those resources that contribute to a particular cost code. The Analysis by Group/Cost report is available as a template report.

Do this:

From the report manager click and select report 9.4 Analysis by Group/Cost (15).

Customise the report and select Sort by Cost Code – Bill Quantity.
Entering a class code in the sieve will print out only those resources that contribute to that particular cost code. By leaving the sieve blank will analyse all the cost codes.

<table>
<thead>
<tr>
<th>L</th>
<th>CODE</th>
<th>RESOURCE NAME</th>
<th>UNIT</th>
<th>P</th>
<th>RATE</th>
<th>UTILISATION</th>
<th>AMOUNT</th>
<th>Labour</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>Labour</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>Unskilled labour (All in)</td>
<td>/Hr</td>
<td></td>
<td>5.25</td>
<td>5,784.15</td>
<td>30,366.80</td>
<td>30,366.80</td>
<td></td>
</tr>
<tr>
<td>219</td>
<td>Charge Hand</td>
<td>/Hr</td>
<td></td>
<td>7.50</td>
<td>2,147.64</td>
<td>16,107.30</td>
<td>16,107.30</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Labour</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>46,474.10</td>
<td>46,474.10</td>
<td></td>
</tr>
<tr>
<td>360</td>
<td>Plant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>300</td>
<td>CAT 215 Excavator</td>
<td>/Hr</td>
<td></td>
<td>230.00</td>
<td>32.77</td>
<td>7,537.31</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Plant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7,537.31</td>
<td></td>
<td></td>
</tr>
<tr>
<td>401</td>
<td>Fuel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>Diesel</td>
<td>/ltr</td>
<td></td>
<td>2.50</td>
<td>491.56</td>
<td>1,229.91</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fuel</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1,229.91</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tracer report**

The Tracer report will list all the bill items that contribute to a particular cost code. The tracer report is available under the **Check and Review Reports** heading.

Print the **Tracer** report and select **Cost Codes** in the tracer selector and confirm.

Type in the cost code 401 and click **OK**.
Chapter 16. Controlling Labour and Plant using Task Codes

The Cost Code provides resource-based control for managing fixed resources such as Materials. The Cost Code will provide limited control to productive resources such as Plant and Labour. The engineering site staff will require the Labour and Plant allowable in more detail typically the allowable per Task on site.

Candy provides a simple method of summarising the Bill items into Tasks. The allowable for each bill item is broken down into the various Resource Types, so we immediately have the Labour and Plant allowable for each Task, the exact information required to control the productive resources.

The Task Code is used to implement Functional Control on the Job and summarises bill items into categories of Function or Activity.

The key is to summarise items with similar production, e.g. bulk earthworks items would be summarised separately to hand excavation. We would use machines for bulk earthworks and labour for hand excavation.

By summarising items with like production we are summarising items with like resources and therefore like cost sensitivity. If our machine is not being used effectively, it is costing a lot more than if our labour is not being productive. We would have different controls on our plant versus our labour.

16.1 Defining the Task codes

The task codes must be defined before allocating them to the Bill items.

Do this:

Open the Definitions and enter the following Task codes.

<table>
<thead>
<tr>
<th>Task Code</th>
<th>Description</th>
<th>Unit</th>
<th>Proj Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>EARTHWORKS</td>
<td>m³</td>
<td>1</td>
</tr>
<tr>
<td>0100</td>
<td>Clear Site</td>
<td>m²</td>
<td>1</td>
</tr>
<tr>
<td>0110</td>
<td>Excavation</td>
<td>m³</td>
<td>1</td>
</tr>
<tr>
<td>1102</td>
<td>Concrete in Foundations</td>
<td>m³</td>
<td>1</td>
</tr>
<tr>
<td>1103</td>
<td>Concrete in Walls</td>
<td>m³</td>
<td>1</td>
</tr>
<tr>
<td>1104</td>
<td>Concrete in Ground slabs</td>
<td>m³</td>
<td>1</td>
</tr>
<tr>
<td>4000</td>
<td>FINISHING TRADES</td>
<td>mm²</td>
<td>1</td>
</tr>
<tr>
<td>4100</td>
<td>Miscellaneous Metalwork</td>
<td>kg</td>
<td>1</td>
</tr>
</tbody>
</table>

Task codes may be summarised into Task code headings. The level column represents the heading level from level 9 to level 1. Therefore, the Earthworks Tasks of Clear site and Excavation may be summarised into the level 1 heading Earthworks. Note the m2 quantity of Clear site must be factorised by 0.10 to calculate the m2 to m3.

The task code accumulates the amount of money and quantity, therefore each task code must have a unit.
16.2  Task code allocation

Create a new document containing the task code columns

Do this:
Open the Bill Document Manager, click on New to add a new template document 1.1 Standard Bill of Quantities.

Rename the new document to 1.1a Bill of Quantities with Task code.

Click Customise and add the following task code columns.
Assign Task Codes

**Do this:**

Open document 1.1a Bill of Quantities with Task code allocation and allocate the following task codes to the bill items.
The Task Code accumulates the amount of Money and Quantity, the Task Factor column is used to determine the quantity that will be added together for each Task code. If the unit of the Bill item is the same as the Task code then a factor of one is used.

There may be instances where the unit of measure of the bill item may be different to the unit of measure of the Task Code.

For example, we may have a bill item measured in linear metres of formwork, yet the bill item has a Task Code with a unit of measurement of m² so we apply a Task factor to factorise the Lm to m². By using a Task factor of 0 the money will be included but not the quantity, for example we may wish to add the cost of wood float finish to Task Code Concrete in Ground Slabs but we only require the quantity of the Concrete in Ground Slabs and not the quantity of the wood float finish. Allocate Task codes and factors to each of the bill items.
16.3 Task code analysis

Price Plug rate to a least a Split rate

In order to calculate the Task Code summary no plug rate items may exist in the job. Page 1/ Item A Clear site was priced as a Plug rate, so we must convert the Plug rate to at least a Split rate.

Do this:
Open document 1.5 Split Rate Pricing and enter 10 in the plant resource type column for Page 1/ Item A to convert the pricing of this item from a plug rate to a split rate.

On-screen Task code analysis

Do an on-screen task analysis, click Finalisation > Job analysis > Job analysis by Task code.

Select document: 00 JOB: PROJECT ANALYSIS CODES

Click Yes.

Select document: 00 JOB: PROJECT ANALYSIS CODES
Update the values by clicking on **Update Codes**.

Click [Yes].

Click [OK].

Note that the Total Quantity, Amount and derived rate is calculated for each Task Code. When finalising a tender if the derived rate is much lower or higher compared to previous tenders then relevant items can be investigated for possible errors in the pricing worksheets.

The total allowable for Labour is calculated for each Task Code, i.e. The Labour allowable for placing concrete in Foundations is **2948.00**. Once progress quantities have been entered for each bill item, the total Labour allowable amount for each Task code is calculated and should be reconciled back to the total Labour cost for each Task code.

Clicking the [Split Rates] or [Split Amounts] toggles between displaying split rates and split amounts for each of the Task Codes.
Note the derived Labour rate to place 1m³ of concrete in Foundations is **14.74** per m³, if the concrete team on site has poured 10m³ then you should not have spent more than **10 x 14.74 = 147.00** on the Labour team.

The site clerk will allocate the Labour team’s cost to the relevant Task Codes which should be reconciled to the Labour allowable based on the work that has been completed on site.

A similar approach should be followed to control Plant.

Totals for Task code headings may be displayed by placing the cursor on the heading and pressing Ctrl-Up and Down Arrow.
16.4 Task code reports

Various Task code reports are available in the Estimating Report Manager under Project Code Reports.

Project Codes Report

The project codes report will list the bill items in Task Code order with a total for each Task Code. Print the Project Codes report.

Select Task code as Primary and none as the secondary and click OK.
Select *Bill and summary, Net* rate and *Spreadsheet* format and click [OK].

**Page 1 & 2** List the bill items in Task code order

<table>
<thead>
<tr>
<th>PAGE</th>
<th>ITEM</th>
<th>PRICING</th>
<th>DESCRIPTION</th>
<th>UNIT</th>
<th>QUANTITY</th>
<th>AMOUNT</th>
<th>Labour</th>
<th>Plant</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 A</td>
<td>E10003</td>
<td>Clear Site</td>
<td>Clear Site</td>
<td>m²</td>
<td>2.00</td>
<td>20,004.00</td>
<td>10.00</td>
<td>10.00</td>
</tr>
<tr>
<td>1</td>
<td>A</td>
<td>Clear Site</td>
<td>Clear Site</td>
<td>m²</td>
<td>2.00</td>
<td>20,004.00</td>
<td>10.00</td>
<td>10.00</td>
</tr>
</tbody>
</table>

**Page 3** Shows the Task code summary

<table>
<thead>
<tr>
<th>CODE</th>
<th>DESCRIPTION</th>
<th>AMOUNT</th>
<th>Labour</th>
<th>Plant</th>
<th>Material</th>
</tr>
</thead>
<tbody>
<tr>
<td>010</td>
<td>Clear Site</td>
<td>20,004.00</td>
<td>10.00</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Excavation</td>
<td>3,004.00</td>
<td>1.00</td>
<td>2.00</td>
<td>8.00</td>
</tr>
<tr>
<td>115</td>
<td>Excavate bases 0 - 2 m deep</td>
<td>3,154.00</td>
<td>31.50</td>
<td>31.50</td>
<td></td>
</tr>
<tr>
<td>120</td>
<td>Excavate foundations 0 - 1 m deep</td>
<td>10,004.00</td>
<td>54.00</td>
<td>54.00</td>
<td></td>
</tr>
<tr>
<td>125</td>
<td>Excavate for Pit or Bump</td>
<td>8,100.00</td>
<td>54.00</td>
<td>54.00</td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>Excavate for retaining wall footings</td>
<td>16,200.00</td>
<td>54.00</td>
<td>54.00</td>
<td></td>
</tr>
<tr>
<td>135</td>
<td>Excavate for foundations 4 - 6 m deep</td>
<td>4,536.00</td>
<td>4.57</td>
<td>0.32</td>
<td>4.63</td>
</tr>
<tr>
<td>140</td>
<td>Excavate for foundations 6 - 8 m deep</td>
<td>4,725.00</td>
<td>9.50</td>
<td>0.52</td>
<td>7.71</td>
</tr>
<tr>
<td>145</td>
<td>Excavation</td>
<td>50,536.00</td>
<td>31,371.00</td>
<td>9,925.00</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>Concrete in foundations</td>
<td>53,264.00</td>
<td>2,500.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

121.
Project Codes Quantity Summary
The Project Codes Quantity Summary report lists the total quantity for each task.
The project code quantity summary report is available in the template reports.

Do this:
From the report manager click and select report 11.5 Project Codes Quantity Summary.

Print the report.

Select Task code as Primary and none as the secondary and click OK.
Project Codes Resource analysis
A complete resource analysis for each Task code may be printed with totals for each Cost code per Task code.

Do this:
Print the Project Codes Resource Analysis.
Select Analyse complexes to level 9, Print codes separately and Summary by Cost Code.

Select Task code as Primary and none as the secondary and click OK.
Page 1 - 10: Lists the resource analysis per Task and the Cost code summary per Task
Chapter 17. Forecasting the BOQ using Candy Planning

Bill items in the B.O.Q can be linked to the activities in a program. Once the link is established, a time-based forecast of cost, value, resources or quantities from Candy Estimating can be analysed using the facilities in Candy Planning.

The simplest approach to link the bill to the program is to use the Bill of Quantities when creating the Program. The Bill section headings are imported as activities into the Candy Planning and the Bill items in the section are linked to these activities. A well-structured Bill of Quantities provides a good platform to create the program. After the creation stage, it is a normal program and it can be adjusted as required.
17.1 Candy Planning Program Manager

Do this:
Change the application tab to Planning.
Choose Main > Program Manager.

Many programs can exist in one Candy job. The Program Manager is used to easily structure and manage your programs. The Program Manager makes it easy to create new programs and is the entry point for existing programs. Programs can also be copied, customised, backed up or recovered.
17.2 **Create a new Program**

Click [New](#) and enter the following information and confirm.

![New Program dialog box](image)

Now select the Tender Program by clicking on [Select](#).

![Program Manager](image)
17.3 Create program activities using the Bill of Quantities

Do this:

Choose Documents > Planning Documents or click on .

Select document 1.1 Standard Barchart. This layout shows the Activity number, Activity Description, Duration and the Barchart.

To import the Bill items, click on the document menu Estimate > Import estimate bill.
We will create activities using the Bill of Quantities section headings. A typical Bill has too much detail for each bill item to be an activity so rather import the headings above bill items and click OK.

Notice each Bill section heading is used to create a dummy activity of 5-day duration.
To re-arrange the Activities and create the logic, click on Activity A010 Concrete, move it below Activity A020 H.D Bolts and miscellaneous metalwork by holding down Ctrl + Right-arrow once.
17.4 Draw your program

Do this:
Change the duration of each of the activities by clicking to the right of the activity, hold the left mouse button down and increase the activity duration. Clicking to the left of the activity allows the user to change the starting position of each activity.

Now move the bars to achieve the following:
Activity A020 Concrete must have a start lead of 32 days on Activity A000 Excavation
Activity A010 H.D. Bolts and miscellaneous metalwork must have a start lead of 12 days on Activity A020
Adjust the % offsets

Do this:

Change the application tab to **Forecasting**

Click on ☐ to open the Forecasting Document Manager and select Tender Program from the Program Selector. Open document **3.2 Activities with BOQ Allocations**. Each activity is displayed with the Bill of Quantities item that has been allocated to the activity. The black bar within the red bar demonstrates where over the activity the bill item has been allocated.

Offset the spread of the Bill items on page 1 over activity **A000 Excavation** by clicking within the activity and dragging the black allocation bar to following positions.
17.5 **B.O.Q with Budget Forecast**

**Do this:**
Click on 🎨 to open the Forecasting Document Manager and select document **4.1 BOQ with Budget Forecast**

The forecast B.O.Q Net amounts are displayed across the program time.

<table>
<thead>
<tr>
<th>Page/Item</th>
<th>Bill description</th>
<th>Final Quantity</th>
<th>Final Unit Cost</th>
<th>Final Net Amount</th>
<th>Forecast Unit Cost</th>
<th>Forecast Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Clear SIT</td>
<td>2,000m³</td>
<td>20,600.00</td>
<td>20,600.00</td>
<td>26,800.00</td>
<td>26,800.00</td>
</tr>
<tr>
<td>1/F</td>
<td>Remove top soil 160mm thick</td>
<td>100m³</td>
<td>3,800.00</td>
<td>3,800.00</td>
<td>5,800.00</td>
<td>5,800.00</td>
</tr>
<tr>
<td>1/G</td>
<td>Excavate bases 0 - 2 m deep</td>
<td>500m³</td>
<td>5,190.00</td>
<td>263</td>
<td>2,238</td>
<td>711</td>
</tr>
<tr>
<td>1/F</td>
<td>Excavate foundations 0 - 2 m deep</td>
<td>200m³</td>
<td>10,800.00</td>
<td>697</td>
<td>7,665</td>
<td>2,435</td>
</tr>
<tr>
<td>1/E</td>
<td>Excavate for pit on surp</td>
<td>100m³</td>
<td>5,190.00</td>
<td>523</td>
<td>5,748</td>
<td>1,829</td>
</tr>
<tr>
<td>1/F</td>
<td>Excavate for retaining wall footings</td>
<td>200m³</td>
<td>16,200.00</td>
<td>1,846</td>
<td>11,407</td>
<td>3,368</td>
</tr>
<tr>
<td>1/F</td>
<td>Excavate for foundations d - 2 m deep</td>
<td>400m³</td>
<td>4,530.00</td>
<td>2,689</td>
<td>4,860</td>
<td></td>
</tr>
<tr>
<td>1/N</td>
<td>Excavate for foundations d - 2 m deep</td>
<td>500m³</td>
<td>4,750.00</td>
<td>2,754</td>
<td>5,950</td>
<td></td>
</tr>
</tbody>
</table>

| 2         | H.D. Bolts and miscellaneous metalwork | 98,223.10 |
| 2/A       | Supply, place and set into position, hot dip galvanised H.D. bolts | 260kg | 5,877.58 | 4,702 | 1,176 |
| 2/B       | M32 HD bolts in lengths ex. 750mm and 8½. 1500mm overall length | 25kg | 45,695.28 | 38,476 | 9,110 |
| 2/G       | The following in galvanised mild steel | 200kg | 21,507.00 | 15,827 | 5,382 |
| 2/F       | 60 x 8mm flat section welded to L | 250kg | 3,544.28 | 2,036 | 789 |
| 2/E       | 60 x 50 x 6mm L-Section frame | 6,939.48 | 6,562 | 1,388 |
| 2/F       | 60 x 8mm flat section lag 188mm long | 750kg | 1,260.00 | 1,009 | 272 |

| 3         | Concrete | 116,172.70 |
| 3/A       | 20MPa Concrete in foundations | 200m³ | 53,348.00 | 53,348 |
| 3/B       | 20MPa Concrete in walls | 200m³ | 41,655.68 | 41,655 |
| 3/C       | 26 MPa Concrete in surfacebess | 200m³ | 21,769.28 | 21,769 |
17.6 Resource usage forecast

The resource usage forecast document is available as a template document.

Do this:
Click on **Resource Usage Forecast**

The resource forecast per bill item is shown in this document. Item 1/A & 1/B have been priced using split rates and therefore do not have any resource usage forecast information.
17.7 **Cost code budget**

A budget forecast can be analysed against cost codes. The cost code budget document is available as a template document.

**Do this:**

Click on [ ] to open the Forecasting Document Manager and select document **4.5 Cost Code Budget**

Click [ ] to view the totals.

and [ ] to confirm.

and [ ] to confirm.

![Image](image-url)
17.8 Resource Histogram

Do this:
Click on \( \text{Barchart} \) to open the Forecasting Document Manager and select document 2.1 Standard Barchart.

Click on the Histogram > Estimate resources document menu.

Select 200 Unskilled Labour (etc) using the \( \text{\rightarrow} \) and confirm.
The Unskilled Labour histogram is displayed.

Now move Activity A020 Concrete to have an end to start relationship with Activity A000 Excavation and calculate the program. Then redo the Unskilled Labour histogram.

Note that the result is the level resource usage.
The histogram type can be changed to show daily or cumulative values. Choose **Histogram > Histogram options** from the document menus.

Select Plot cumulative values and confirm.

Place your cursor at the end of the curve and the total usage of **5 784.15 Hours** for the unskilled labour is shown on the bottom left of the document.
Chapter 18. Valuations

The Candy Valuations is used for the post tender stage of a project. The Bill of Quantities created in Candy Estimating is available in Candy Valuations, the difference between Estimating and Valuations is the extra Valuation quantity columns, Valuation layouts and the Valuation reports.

Do this: Choose the Valuations application tab.

18.1 Valuation Setup

The initial Valuation and every Valuation thereafter commences at the Valuation Setup process listed below:

Step 1: Duplicate & Rename the Job
Step 2: Valuation Setup

Step 1: Duplicate and rename the job.

It is good practice to copy the job before entering the new monthly valuation quantities. Eventually the Q.S will have and electronic copy for each Valuation in Candy, and if required, can back track to previous valuations.

Do this: Go to the Job manager, select Waste Water Treatment Works, right click on Job and select Duplicate job then rename it to Waste Water Treatment Works – Valuation No.1
Step 2: Valuation Setup

Open *Waste Water Treatment Works – Valuation No.1*, in Valuations click on the Main menu option. The “Initial Valuation setup” window will open.

**Do this:**
- Click on ☻ to change the date to the first Valuation date.
- Type in the Valuation header “Valuation No.1.”
- Click on OK.

![Initial Valuation setup window](image)

Then select the appropriate option in the next window.

![Costs and Allowables options window](image)

In the Main menu select Valuation setup > Financial calendar.
In the Financial calendar, enter the Valuation setup dates for the full duration of the project as per the example below by double clicking in the date column.

Once the Financial calendar has been setup in Valuation 1, Step 2 for the valuations that follow will be **Valuation Setup > Setup next Valuation.**
Valuation Document

Do this:

Click on or Open the Valuation Document Manager Documents > Valuation Document Manager

Duplicate document 2.2 Primary Valuation Entry & rename it to 2.2a Standard Primary Valuation Entry

Select document 2.2 Primary Valuation Entry Click on to select the columns required in the Valuation document
Select the required columns as per the above layout and click **OK**.
18.2 Primary Valuation Quantities

This document contains the three primary progress quantities available in the system.

**Current Actual Quantity** - This quantity is used to record how much work has Actually been done against bill items. Think of it as an Internal quantity.

**Current Claimed Quantity** - This quantity is used to record how much you are Claiming in an application for payment. Think of it as an External quantity.

**Current Paid Quantity** - This quantity is used to record how much the client has paid you.

18.3 Copy the Final quantity from the Bill quantity

The bill quantity will normally be used for the first Final Value projection and as a starting point can be copied to the Final quantity column. This should be done before entering any valuation quantities.

*Do this:*
Right-click on the Final Quantity column header and select

*Copy from selected quantity.*
Select the **Bill Quantity** as the source quantity and confirm.

![SOURCE Select Quantity dialog box](image)

Click **Yes**

...and **OK**

![Copying quantities dialog box](image)

![Quantity copy dialog box](image)

![2.2a Standard Primary Valuation Entry table](image)
Adjust the Final Quantities

The final quantity can be adjusted to suit the new final without affecting the billed quantity. Increase the final quantity for item A and B on Page 1.
Enter the Valuation quantities

Do this:

Page 1:

Entering the Actual quantity automatically updates the claimed and paid quantity columns. The claimed quantity can be updated to reflect over claims.

Note the percentages are updated as the quantities are entered, alternatively the percentages could be entered which would then generate the quantities.

Page 2:

Progress the all metalwork items to 20% using the Actual % Bill column.
Page 2:
Update the claimed quantity by typing in the quantities in the Current Claimed quantity column.

Page 3:
Progress the concrete item.
18.4 **Valuation Report Manager**

Print the following Valuation reports from the Valuation Report Manager

**Interim Payment Claim report**

The Interim Payment Claim is always based on Claimed Quantity and can only be based on the Gross and Selling rate.

**Do this:**

Click on 🏛️ to access the Valuations Job Manager, double click on Valuation Bills and select Interim Payment Claim, click ☑️

Select the following options then click ☑️️.
Valuation Listings report
The Valuation Listings report can be based on any Valuation Quantity and can be based on the Net, Gross or Selling rate.

**Do this:**
Return to the Valuation Document Manager and select Valuation Listings Report then select [Customise] and

Select the following options and click [OK].
Select **Actual Quantity**

Select Quantity window showing options such as:
- Actual Qty remaining (Final - Actual)
- Actual Month’s Qty (Actual - Prev Actual)
- Claimed Quantity
- Claimed Qty remaining (Final - Claimed)
- Claimed Month’s Qty (Claim - Prev Claim)
- Paid Quantity
- Paid Qty remaining (Final - Paid)
- Paid Month’s Qty (Paid - Prev Paid)
- Over Claimed Mth’s Qty
- Over Claimed Quantity (Claim - Paid)
- Over Paid Mth’s Qty
- Over Paid Quantity (Paid - Actual)
- Over Valued Mth’s Qty
- Over Valued Quantity (Claim - Actual)
- Variation Quantity (Final - Bil)
- Final Quantity
- Bill Quantity
- User Qty (User defined)
- User Variation Qty (User - Actual)
- User Remaining Qty (Final - User)
Valuation Resource Analysis report

The Valuation Resource Analysis can be based on any Valuation quantity. Printing this report on Actual Quantity will list the resource and cost allowable to date.

**Do this:**

Return to the Valuation Document Manager and double click on Resource Analysis Reports and select Valuation Resource Analysis report then select **Customise** and

Select the following options and click **OK**

...and select **Actual Quantity**
Project Codes Resource Analysis report
This report prints the Resource Analysis split into the Task codes. Printing this report on Actual Quantity will list the resource and cost allowable to date per Task code.

_Do this:_
Return to the Valuation Document Manager and double click on Project Codes Reports and click on Project Codes Analysis report then select and

Select the following options...

![Project Code Resource Analysis dialog box]

...and choose _Actual Quantity_

![Select Quantity dialog box]
Select *Allowable rates*

Choose *Task code* as the Primary code and *None* as Secondary.

Click **OK**.
18.5 Valuation Trade Total Display

Trade summary can be based on any Valuation Quantity and Rate.

_Do this:_

Click on the tool button **TT** select Actual Quantity and select Net rate.